QuickCharmStats 1.1
for PC

Installation Guide
&
Software Manual

by Kristi Winters and Martin Friedrichs (CS programmer)
Contents

Welcome ........................................................................................................................................... 6

Software downloads and setup ........................................................................................................... 7
  Java ................................................................................................................................................. 7
  MySQL ........................................................................................................................................ 10
  QuickCharmStats ......................................................................................................................... 15
  Download QCS 1.1 ....................................................................................................................... 15
  Connecting to MySQL .................................................................................................................. 19
  Create a QCS shortcut on your desktop ....................................................................................... 20
  Uninstall the CharmStats Database ............................................................................................ 21
  Remove QuickCharmStats ........................................................................................................... 21

The QuickCharmStats Interface ....................................................................................................... 22
  Login to QCS ................................................................................................................................. 22
  The Menu bar ............................................................................................................................... 22
  The Tool Bar ................................................................................................................................ 23
  Windows ....................................................................................................................................... 24

Get ready: collect your documentation, create a plan .................................................................... 26
  Planning your harmonization ......................................................................................................... 26

Working with QuickCharmStats, step-by-step .............................................................................. 27

Prepare your Metadata for importation ......................................................................................... 27
  Import data using SPSS ................................................................................................................ 28
  Import data using Stat/Transfer for Stata .................................................................................... 29

Import Metadata into CharmStats .................................................................................................. 30
  Source variables .......................................................................................................................... 30
  Import Measurements (Target Variables) ................................................................................... 35

Create a Quick Charm harmonization ............................................................................................ 38
  Name your project (Project Setup name required) ..................................................................... 38
  How to search for measurements and save them to a basket .................................................... 39
  How to search for a source variable ............................................................................................. 40
Assign a target variable name and label ........................................................................................................ 40
Import your Measurement into your Project ........................................................................................................ 41
Bring your source variable into your project .......................................................................................................... 41
Map the values .................................................................................................................................................. 42
The Report and Graph features ............................................................................................................................ 43
Publish CS Report as html ..................................................................................................................................... 44
Save Graph as Graphic file ................................................................................................................................... 44
Creating a target variable and multiple variables .................................................................................................. 45
Exercise - Create a target variable inside CharmStats ........................................................................................ 45
Export Syntax ...................................................................................................................................................... 57
Finish your QCS projects ..................................................................................................................................... 58
Troubleshooting .................................................................................................................................................. 58
Troubleshooting privileges (QCS 1.1) ................................................................................................................ 59
Release Lock on Project ....................................................................................................................................... 59
Revoke ‘Finished’ Status for a Project ................................................................................................................... 60
Change Password ................................................................................................................................................. 60
Differences between QCS 1.0 and QCS 1.1 ........................................................................................................ 61
Appendix A: Quick Start guide to QuickCharm ..................................................................................................... 64
Quick Start Data Importation: Import variables from an SPSS dataset ............................................................... 64
Create a QuickCharm project, search for and import variables, create syntax ................................................. 64
Search for and save measurements and variables into your basket ................................................................. 64
Create a new QuickCharm .................................................................................................................................. 64
Export Syntax from an existing project ................................................................................................................ 65
Appendix B: Quick CharmStats Menu Structure ................................................................................................ 66
Appendix C: Fast access to Menu through Short cuts: ....................................................................................... 67
Appendix D: Tooltip workflow ............................................................................................................................ 68
Search ................................................................................................................................................................. 68
QuickCharm ....................................................................................................................................................... 68
Additional Harmonizations ................................................................................................................................. 68
Appendix E: List of Tags supported by the Report Generator...............................................................70
Appendix F: The Standard Report Template .....................................................................................71
Welcome to QuickCharmStats (QCS)! We have designed this software to reduce the time and effort researchers spend harmonizing and recoding variables in preparation for statistical analysis. QCS is also free and open-source to ensure anyone who wants to use it can do so.

QuickCharmStats (QCS) is designed for researchers who want to quickly and easily create recoding syntax for use in statistical analysis. QCS allows you to import the necessary metadata information from SPSS and Stat/Transfer. Once the metadata has been imported into QCS you can search for the variables you need, import them into a project and quickly produce syntax(es) to harmonize variables in SPSS and Stata. Included in this QCS version are two further features: Reports and Graphs.

The report feature allows you to choose from Templates and instantly create an .html file based on the information you have used in your project. Use this features to save your documentation and bibliographical information, notes containing coding explanations, as well as the harmonization syntax. Share it with others at anytime, anywhere, or to post it online as a reference.

The graph feature provides you a visual image of your harmonization at various stages of the process. These graphs can be saved as .jpegs and used in presentations or included as part of your documentation.

To help you get the most out of the software, this manual has three aims. The first is to walk you through the download and installation process. The second aim of this manual is to explain the standards of transparency and replicability that underpin information CharmStats collects and how it helps you manage your data. The final aim is to ensure you understand the program’s workflow and feel confident creating harmonization projects and generating reports and graphs.

We recommend you take the time to go through the workbook section of this manual and use the example project data provided in the download package. The example will introduce you to the CharmStats workflow which starts with the target variable and then connects to the source variable(s). We provide you with suggestions for organizing your QuickCharm projects for future reference and reuse. By working through the example project you will get the most out of QCS in very short time.

We believe that after investing a short amount of time learning how to create projects you’ll save time and effort. As importantly, this software should prevent you having to recreate your harmonization work.

As you expand your use of CharmStats we are interested in hearing about your experience with CharmStats and what additional features would be useful to you. Please contact us at charmstats@gesis.org.
SOFTWARE DOWNLOADS AND SETUP

To use QCS you will need two free software programs: JAVA and MySQL. If you do not have these, we walk you through the download and installation process. If you do, skip to the subheading ‘CharmStats’. The estimated time to complete the three software downloads and installations on your computer is around 30 minutes (depending upon your connection speed).

JAVA

QuickCharmStats is a JAVA based application. To run QCS use JAVA version 1.6 or higher. If you do not have Java 1.6 proceed with the Java installation. If your version is at least 1.6., skip ahead to the MySQL installation. Here is how you can check which version you have and how you can update to a newer version.

To check which version of Java you have use the command: java -version at the command line. Click the Start button to bring up the search box.

Type cmd.exe to bring up the program.

Start cmd.exe with a double click and you will see this window:

After the ‘>’ prompt enter: java –version (note the space before the - ).
The result will indicate which version of Java is installed on your computer.

If you do not have Java 1.6 proceed with the Java installation. If your version is at least 1.6., skip ahead to the MySQL installation. **Note:** when your Java installation completes, you may need to restart your browser (close all browser windows and re-open) to enable the Java installation.

**Need Java or need an update? Start by clicking here:**
Phases of the Java installation

These screenshots correspond to the installation steps you will see on the screen.

Phase 1

Phase 2

Phase 3

Phase 4

Phase 5

When you have completed this installation, the next step is the MySQL installation.
CharmStats software works by storing persistent information in a relational database. The MySQL DBMS was chosen as the system to manage the database and its content. MySQL is a product from ORACLE, and is free to download from www.mysql.com.

Because it is specialist software, unlike JAVA, chances are that MySQL is not installed on your computer. A good rule is if you don't know whether or not you have MySQL on your computer, you probably don't. If this is the case, you have to install MySQL.

Hint: Annoyingly, sometimes the configuration of the MySQL Server fails. A common reason is that the User does not have the rights to make changes to the system. In this case, you can try to run MySQLInstanceConfig.exe on its own as the Admin.

Click on the link below to go to the website: http://downloads.mysql.com/archives/community/
Search for the 5.0.51b version.

We recommend downloading (mysql-5.0.51b-win32.zip).
At the end you may see this Setup.exe.

If you do not see this window because you do not have WinZip, go to your Downloads folder. Open the mysql-5.0.51b-win32.zip with Windows Explorer.

Right-click to open the folder with Windows Explorer, the Setup.exe should appear.

Start installation by double clicking “Setup.exe” in WinZip or in the folder “mysql-5.0.51b-win32”. The following window will open:
Press **Next** to get to this screen:

![MySQL Server 5.0 - Setup Wizard](Image)

Press **Install** to continue, and this screen will appear:

![MySQL Server 5.0 - Setup Wizard](Image)

Press **Next** to get the next screen:

![MySQL Server 5.0 - Setup Wizard](Image)
Press **Finish** to get the next screen:

Choose Standard Configuration and press **Next**.

Check that the same options on your screen as are shown. Press **Next** to continue.
Make sure your options are the same as shown. Select a password of your choice, and make a note of it. You will need it later in the installation process.

Press **Next** to continue.

Press **Execute**.

Press **Finish** to end the installation process. Almost there! The final step will be to download and install QuickCharmStats on your laptop. We walk you through that process next.
QUICKCHARMSTATS

In this section we will walk you through the following steps:

1. Download QCS 1.1 from the GESIS website

2. Install QuickCharmStats
   a. Unzip the QCS file you downloaded
   b. Copy the folder containing QCS to your desktop
   c. Connect QCS to MySQL (nb: have your password from the MxSQL setup)
   d. Save QCS as a desktop shortcut.

This tutorial includes opening .zip files. We demonstrate how to open .zip files with software already on your Windows system, however you may also open it with WinZip.

DOWNLOAD QCS 1.1

To get started with your QCS download, please go to the GESIS website by clicking on the link below: http://www.gesis.org/en/services/data-analysis/data-harmonization/register/

We will email you a username, password and link to a special web page. You download the information from this webpage due to the size of the file, which at the time of printing is about 70MB. Start by filling in the required information. (Webpage might not look as pictured.)
Confirm the information entered. (Webpage might not look as pictured.)

When the email arrives click the link attached within to start your download.

Get Quick-Charmstats
powermail <holger.heuser@gesis.org>
Sent: Mon 19.05.2014 14:14
To: [Redacted]

Thank you for your registration!

You can download QC here...

Quick-Charmstats

Please enter the following login data to get access to the download area:

Click on the link and you will land on this page. Enter your username, password and login.
Double click the link to start your download.

The download will start. Right-click to get the option to ‘Show in Folder’ and select it. (Your version will be QCS Download 1.1.)

When the folder opens, find the QCS 1.1 zip file. Right-click to bring up the option to ‘Open with’. Left-click on Windows Explorer.

This will bring up the contents of the .zip window. The first thing to do is change the location of this folder as it will make it easier to connect QuickCharmStats to your MySQL database.
Copy the downloaded QuickCharmStats folder to your C: drive. (You may copy the QCS 1.1 folder to any drive, but we use the C: drive in this example.)

Drag and drop the QuickCharmStats folder to your C: drive.

This window will pop up:

The QCS folder will now appear in your list.
CONNECTING TO MYSQL

Almost done! The last thing to do is connect QCS 1.1 to your MySQL database, using the password you entered in the previous section. Start by opening the cmd.exe as you did previously.

Run cmd.exe from the Start button prompt as before.

Double click on the program to open it.

When you click the program cmd.exe you will see a similar prompt. Type in the following:
cd[space]drive with QCS:folder name\bin .

For this example the line reads:
cd c:\qcs_download_0.9.7\bin

Hit Enter and you will see this:

Remember your password from step #2? You will use this now and replace your-mysql-password in the next instruction with it. In front of the line of text that reads c:\QCS_Download_(QCS version number) type the following: setup (space) your-mysql-password (space) mysql.sql

For example: setup qwertz mysql.sql
Finally, we’ll show you how to create a QCS shortcut for your desktop to make it faster for you to open the program. Double click the QCS folder to open it. Documentation and the practice dataset can be found in the file doc. Open the folder named bin.

This window will open. Open the QuickCharmStats folder by double clicking on it.

To open and run QCS, double-click the .jar file. You can run QCS directly from this folder location or you can create a shortcut.
Create a desktop shortcut by left-clicking the .jar file once to activate it. Right-click once to bring up this menu:

Select Create shortcut. Left click Create shortcut to activate it, use your mouse to drag it to the Desktop.

Double click on the shortcut to start QCS. 
Allow the program a few seconds to open and welcome to QuickCharmStats!

UNINSTALL THE CHARMSTATS DATABASE

If you ever want to remove the CharmStats database open the command line. Type setup your-mysql-password rem.sql, then press [Return].

REMOVE QUICKCHARMSTATS

To remove QuickCharmStats 1.1 from your computer, delete the folder.
In this section we will review:

- How to open QCS
- The application workspace
- How to log in
- The Menu bar
- The Tool bar

Double click the QCS icon (jar-file) that came with your QuickCharmStats download. This will open the QCS application window.

**LOGIN TO QCS**

To login go to: Menu: User → Login

The login dialog comes up:

The installed default username and password are ‘user’ and ‘user’. These can be changed later under User in the menu bar. Click ‘Save Login’ to set the default username and password to avoid logging in each time you open QCS.

**THE MENU BAR**

The menu bar organizes the activities of QCS for you. Here are the actions available to someone logged in as a ‘user’.
<table>
<thead>
<tr>
<th><strong>File:</strong></th>
<th>Exit (exit the program)</th>
<th><strong>Basket:</strong></th>
<th>Open My Basket</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User:</strong></td>
<td>Login</td>
<td><strong>User:</strong></td>
<td>Login</td>
</tr>
<tr>
<td></td>
<td>Log off</td>
<td></td>
<td>Log off</td>
</tr>
<tr>
<td></td>
<td>Change password</td>
<td></td>
<td>Change password</td>
</tr>
<tr>
<td><strong>Data:</strong></td>
<td>Import Variable</td>
<td><strong>Data:</strong></td>
<td>Import Variable</td>
</tr>
<tr>
<td></td>
<td>Import Measurement</td>
<td><strong>Data:</strong></td>
<td>Import Measurement</td>
</tr>
<tr>
<td></td>
<td>Edit Variable</td>
<td><strong>Data:</strong></td>
<td>Edit Variable</td>
</tr>
<tr>
<td></td>
<td>Edit Measurement</td>
<td><strong>Data:</strong></td>
<td>Edit Measurement</td>
</tr>
<tr>
<td></td>
<td>Export Variable</td>
<td><strong>Data:</strong></td>
<td>Export Variable</td>
</tr>
<tr>
<td></td>
<td>Export Syntax</td>
<td><strong>Data:</strong></td>
<td>Export Syntax</td>
</tr>
<tr>
<td></td>
<td>Remove Variable</td>
<td><strong>Data:</strong></td>
<td>Remove Variable</td>
</tr>
<tr>
<td></td>
<td>Remove Measurement</td>
<td><strong>Data:</strong></td>
<td>Remove Measurement</td>
</tr>
<tr>
<td><strong>Project:</strong></td>
<td>Create new project</td>
<td><strong>Project:</strong></td>
<td>Create new project</td>
</tr>
<tr>
<td></td>
<td>Open project</td>
<td><strong>Project:</strong></td>
<td>Open project</td>
</tr>
<tr>
<td></td>
<td>Close project</td>
<td><strong>Project:</strong></td>
<td>Close project</td>
</tr>
<tr>
<td></td>
<td>Save project</td>
<td><strong>Project:</strong></td>
<td>Save project</td>
</tr>
<tr>
<td></td>
<td>Finish (for unfinished projects)</td>
<td><strong>Project:</strong></td>
<td>Finish (for unfinished projects)</td>
</tr>
<tr>
<td></td>
<td>Remove</td>
<td><strong>Project:</strong></td>
<td>Remove</td>
</tr>
</tbody>
</table>

**THE TOOL BAR**

The Tool bar icons are designed to speed your workflow. Some icons will not work unless a certain stage of a project has been completed (e.g. export syntax activates after mapping is confirmed).

- ![Create new Project](#)
- ![Save Project](#)
- ![Open Project](#)
- ![Export Syntax](#)
- ![Maximize Forms (fills screen)](#)
- ![Maximize Graph](#)
- ![Maximize Report](#)
QuickCharmStats helps you organize all your information so everything you need in one place when you harmonize your variables.

**Project window**

Each project contains 1 target variable and at least 1 source variable. Think of projects as folders that contain all the metadata and mappings you need.

Newly created projects appear in the Unfinished Projects folder. Projects are listed in alphabetical order. This list is updated as new projects are created.

When a Project is created, the Menu tab Project provides additional action, Finish and Remove. Once a harmonization is completed, users Finish their projects, locking them to any further changes. Finished projects can be searched, saved to the Finished Projects folder and opened. To delete an unfinished project, open it and select Remove. Confirm Remove in the dialogue box.

**Basket window**

**Temp Basket**

Under the Project(s) window is the Temp Basket window. After doing a Search, users save target and source variables of interest to this basket. The Temp Basket holds target and source variables until you log out of your session. Variables sent to the Temp Basket are not saved when you close your QCS session, hence the ‘temp’ in the name.

If your Temp Basket becomes overly full while you are working on your harmonizations you can empty it by going to Basket on the menu bar and clicking Empty Temp Basket.

**My Basket**

The My Basket feature allows you to save variables for work across multiple sessions. To switch from the default ‘Temp Basket’ click on Basket in the menu bar. The Temp Basket will be replaced with My Basket. Source and target variables saved here will be stored after your session has ended and can be retrieved by opening My Basket again.
Once My Basket has been open other features in the menu dropdown become activated. You can click Close My Basket if you want to return to using the Temp Basket. You can update the list of variable stored to your basket by clicking Save My Basket. To clear the list of variables you have stored to My Basket, click Empty My Basket.

**Forms window**

Most of the work you do in QCS will take place in the Forms window. The workflow moves from left to right, starting with the Project Setup. This is the area where you will import variable metadata, enter comments, notes and references, connect target and source response options, and confirm the mapping before exporting syntaxes or generating graphs.

QCS was designed to produce the syntax and documentation needed to conduct analysis as quickly as possible. Many non-essential tabs have been turned off, but will be active in CharmStatsPro. The Forms window will be reviewed in detail in future sections.

**Graph window**

The Graph window displays your harmonization visually. These graphs can be saved as .jpegs and incorporated into presentations or articles. This is an example graph using the practice dataset.
Maximize your efficiency! Not only does QCS do the work of visualizing your harmonization work, it also helps you by converting your metadata, notes, comments and references into a document you can store anywhere you like. Create .html links or save it as .pdf. Easily retrieve everything you need at a later time with just one click.

GET READY: COLLECT YOUR DOCUMENTATION, CREATE A PLAN

Getting the most out of CharmStats requires a bit of organization to make the most of your time. Below we present an example of how to plan for your harmonizations. In CharmStats, users harmonize the target variable to a source variable. To help keep things clear we want to introduce two terms we use in this manual:

**Measurement** – the target or harmonized variable.

**Variable** – the source variable that needs to be harmonized.

Collect the relevant information on your target and source variables to plan your harmonization. Start by inspecting the question wording, response options and other instructions or notes in the documentation. Decide how you will handle valid and invalid data (e.g. refused and don’t know responses) in both your target and source variables.

In this example we use the QCS 1.1 practice dataset.sav that came with your download.

PLANNING YOUR HARMONIZATION

The QuickCharmStats 1.1 download includes a practice dataset. In this example we will be recoding political science variables asking about closeness to a party. In this hypothetical example, we are interested in comparing people who do and don’t feel closer to a political party as our concept of comparison. Using the logic that if someone indicates they ‘don’t know’ if they are closer to a party
they aren’t closer to a party, we will be recoding ‘Don’t know’ into ‘No’. For your first few harmonizations we recommend mapping out your coding strategy by hand before using CharmStats, then compare your intention with the QCS graph that displays how your variables were harmonized.

**Example: Harmonizing ‘Closer to a party’ measures**

<table>
<thead>
<tr>
<th>Source: Close to party?</th>
<th>Target variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Yes</td>
<td>1 Yes</td>
</tr>
<tr>
<td>2 No</td>
<td>2 No</td>
</tr>
<tr>
<td>9 Don’t know</td>
<td></td>
</tr>
</tbody>
</table>

This is by-hand process is similar to what CharmStats does when it maps your source variables onto the target variable. As you gain confidence with the software you do not have to draw a map for each harmonization, but you should have some expectation of what your QCS end-product graph will look like based on this process. Using the information on the target and source variables to structure this harmonization, we are now ready to quickly and easily harmonize our data.

**WORKING WITH QUICKCHARMSTATS, STEP-BY-STEP**

To quickly produce your syntax, graphs and reports you need is to complete a few easy steps.

1. Import the target and source variable metadata into the QCS database.
2. Create a new Project.
3. Search your database and save the variables you want to work with into your Temporary Basket.
4. Import your target and source variables into your Project.
5. Map your target values onto your source values.
6. Export your syntax in either SPSS or Stata/ generate a report and save it.

**PREPARE YOUR METADATA FOR IMPORTATION**

QuickCharmStats 1.1 imports variable metadata from SPSS. One import function treats all variables as source variables, the other as target variables. It is fine for you to import the same variable as either a target or source variable into the same dataset. The software will display the target version of the variable in your target searches and the source variable version in the variable search. However, we do not recommend importing the same variable multiple times. A single variable can (and should) be used in multiple projects. Using the same variable instead of importing multiple versions not only saves time, but allows you to look back at all the projects using that variable in your dataset.
When you select a .sav file to import for harmonization you will be offered the option to import every single variable in that dataset. Therefore, if you have only a few variables to harmonize from a much larger dataset, we strongly encourage researchers to create a separate dataset containing only the variable metadata you need.

This is an efficient way to prepare your data for use in QuickCharmStats. We walk you through an efficient way to create a SPSS dataset that will streamline metadata importation. If you intend to create syntax for Stata please note that the variable name must be in small case letters.

**IMPORT DATA USING SPSS**

We recommend you give some thought as to how best organize your variable metadata before working with SPSS. Your SPSS file will look similar to this:

QuickCharmStats automatically imports the following information; Name, Label, Values, Missing into MySQL. To avoid importing every variable in your dataset, we recommend creating a new .sav file that contains only the variables you want to harmonize. Moving variable metadata is easily done with SPSS using the Copy and Paste functions. Open a new dataset in SPSS.

Creating a QCS-ready dataset is as easy as clicking copy and paste. This example (screenshots only) copies variables used in the Comparative Study of Electoral Systems (CSES) with British Election Study (BES) marital status variables for 2005 and 2010. Open the SPSS dataset with the variable(s) that you want to harmonize in the Variable View. Find the variable you require. Right click to bring up the option to Copy a variable.
Go to the new database you have created for harmonizing variables, and right-click on an empty line. Select Paste to insert the new variable metadata.

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>c2004</td>
<td>Numeric</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CSES Respondent’s marital or civil union status</td>
<td></td>
</tr>
</tbody>
</table>

We recommend you examine the variable label. You might find it helpful to add details to the variable label. **However, do not change the variable name.** To differentiate between years, we added the study name to all the variables and the study years to the BES variables.

Save your new SPSS database with a name that helps you recall the content and ideally in a dedicated QCS Harmonization folder that will hold all your harmonization inputs and outputs. You can import the variable metadata into QCS.

**IMPORT DATA USING STAT/TRANSFER FOR STATA**

Metadata in Stata cannot be imported directly into QuickCharmStats. However, Stata files can be converted into SPSS files (.sav files). We recommend that Stata users first prepare a QCS dataset that contains only the variables you need to harmonize and a different dataset for the measurements you want to harmonize. Here are the next steps you can take to import your data into QCS.
1) Import your Stata metadata into the software package R and then change your .dta file into a .sav file.

2) Use Stat/Transfer to convert .dtas into .savs 

3) Email the dataset to charmstats@gesis.org and we can assist you. This may take some time, therefore please put in your request 2 weeks before you need the file for work in QuickCharmStats.

**IMPORT METADATA INTO CHARMSTATS**

Let’s import the metadata we will need to work with the program. We will start with the source variables. In your CQS download there is a Practice Dataset folder with the file ‘QCS 1.1 practice dataset.sav’. The list of variables in this dataset is provided in the .txt file also called QCS 1.1 practice dataset variable names and labels. **NOTE:** Stata syntax is case sensitive. If the variable name – for example C2004 – includes capital letters, you can edit it before or during the import process to make it Stata syntax compatible.

**SOURCE VARIABLES**

The **practice dataset is located in the doc folder that came with your download.** To import source variables into the QuickCharmStats database start by clicking the following:

Menu: Data → Import → Import Variable

Dialog: **Select variable import source** comes up. Search your desktop for the location where the QCS 1.1 practice dataset is stored. File name → (browse, select) → [Open]
When you click open you will be presented with a list of every variable in the dataset. If you want to import them all click Select All. To import selected variables from the list, tick the box of those variables you want and then click Import.

QCS 1.1 walks you through the steps of importing variables more clearly than the 1.0 version did. This means a few more screenshots for you; however the benefit you will also receive a report at the end of the process that details what you’ve imported. You can save this for your records to help you manage your database.

The first information dialog box informing you that variable importation has started. Click OK to continue.

HINT: You can always edit a variable or a measurement by using the menu bar Data → Edit Variable/Measurement.

The second indicates which variable metadata you will review and edit first. Click OK to bring up the imported variable’s metadata.

Dialog: Edit Variable → Variable tab → Name, Label, Type, Level, Measure

**Variable Tab.** The Edit Variable window has three tabs. The first, the Variable tab, displays the information you imported from SPSS. Please note the Missing column. If you indicate a value is a missing value (often represented by 9 or 99) and therefore invalid data, you can tick the box. You do not have to enter more metadata, however if you want to add or edit information, here are the buttons that change information on the variable level.

You can leave imported data as ‘Original’ under Type. Change the sampling level to either the individual or aggregate levels. Finally you can indicate the measurement type or change it here. Repeat this for each variable.
Other buttons:

Add Value: Edit the variable by adding a value that did not appear in the original dataset.

Comment: Keep your notes on coding decisions or other information by adding it to the comments section. This information will be stored with the variable.

Definition: Provide the theoretical definition that guides your interpretation of this measure.

Dataset: Enter in the study number (its permanent identifier, or PID), the study name and any other comments about the source of the data. This information is connected to the variable, not to the Study tab. Consider this the informal information on the study, and the Study tab the information you will need to provide only if you decide to publish your harmonization work as a reference.

Reset Changes: Undoes your changes and returns the information to what was imported.

Apply Changes: Confirms your changes to the database. You must press this button to continue the importation process.

Exit ‘Edit Variable’: Prompts the closing of the window. Confirm changes by clicking ‘Yes’.

Help: Not activated in this version.

Question Tab (opt.)

(Dialog: Edit variable → Question tab → Text, Instruction)

An optional information tab is available to record the question level information in this version of QuickCharmStats.

Name: If the question is given a name in the survey you can enter that here. Alternatively you can create your own name for variables of these types.
**Text:** Copy and paste the exact question wording into this area. This is helpful when the variable label contains only part of the question wording or none at all.

**Instruction:** Copy and paste any interviewer instructions here (e.g., ‘Ask all adults’ or ‘Rotate response options’). A good criteria for what is relevant information is whether the information would inform how someone replicated the question in future.

**Intention:** In this area you can make comments about what the question wording is intended to capture. This will be more important in future versions of CharmStats which will allow users to harmonize composite variables including indexes, scales and typologies.

**Definition:** If you are using a particular definition of this concept. Alternatively if it is a new measure you can specific the definition that informed it.

---

**Study tab (opt.)**

(Dialog: Edit variable → Study tab → Study title, Study area, Dates of Collection, Population, Selection, Collection Method, Collectors) → [Save]

An optional information tab is available to record the question level information in this version of QuickCharmStats.

**Study title:** Name of the study from which you have used data. For example, British Election Study, 2010: Face-to-Face Survey.

**DOI:** The permanent identifier associated with the study (e.g. 10.5255/UKDA-SN-7529-1).

**Study area:** Here you can indicate the geographical space(s) from which the data came.

**Dates of Collection:** Information on start and finish dates of the data collection.

**Population:** Report on the population sampled (e.g. All adult GB residents).

**Selection:** Indicate the sampling method here (e.g. stratified sampling, quota sampling).

**Collection Method:** Report here whether the data were collected by phone, in-person or online.

**Collectors:** Report the academics, consortium, group or firm who collected the data.

**Source file:** Provide a link to the dataset.

**Dataset:** List the name of the dataset.

**Definition:** You can make notes here about the aims of the study.
Other information QCS provides is a window to confirm you want to import the variable. Here you can either import the variable, skip the named variable and move on to the next or abort the whole process. If you select Abort all Imports CharmStats stops importing variables from the dataset from that point forward. To restate, selecting abort will stop all variables being imported including the one displayed in the text ‘Do you really want to import variable variablename’.

![Image](image1.png)

After you select ‘Yes, import now’ you will see a report that your variable has been successfully imported.

![Image](image2.png)

Repeat this for each of the source variables you have selected from the list at the start of the importation process. When you have finished importing all the variables you have selected you will see this dialog box that indicates how many variable you have imported into the database.

A new feature of QCS 1.1 is a report that displays information on the variables you have imported. You can save this information as a separate file for later consultation or to share with colleagues.

![Image](image3.png)
IMPORT MEASUREMENTS (TARGET VARIABLES)

Importing target variables is nearly identical to importing source variables. The practice dataset is located in the doc folder that came with your download. To import target variables into the QuickCharmStats database start by clicking the following: Menu: Data → Import → Import Measurement

Select the same practice dataset used to import the source variables.

Dialog: Select Measurement for Import comes up. Click OK to continue. File name → (browse, select) → [Open]

When you click open you will be presented with a list of every variable in the dataset. CharmStats treats source and target variables as different types of information. This means you can import the same variable as a source or a target variable and the software will treat them as different elements in the workflow. To import them all click Select All. To import selected variables from the list, tick the box of those variables you want and then click Import. For this example we are importing the variable PIDTARGE.

The dialog box indicates how many target variables you will review and edit.

HINT:
Edit variable or a measurement from the menu bar Data → Edit Variable/Measurement.
The next message indicates the importation process has started. Click OK to bring up the imported variable’s metadata.

Dialog: Edit Measurement → Name, Abbreviation, Level, Source, Kind, is Template

The Edit Measurement window displays the metadata imported from SPSS. Please note the Missing column. If you indicate a value is a missing value (often represented by 9 or 99) and therefore invalid data, you can tick the box.

Review that the variable name, label and other metadata is correct. You can leave imported data as ‘Imported’ under Type. Change the sampling level to either the individual or aggregate levels. You can indicate the measurement type or change it here. You do not have to enter more metadata, however if you want to add or edit information, here are the buttons that change information on the variable level.

NOTE: If you are importing a variable that will be used as a template for creating new target variables in future (for instance a generic 11 point scale, Likert scale or thermometer scale to be adapted for particular questions) you can indicate that ticking by ‘is Template’. For daily use when harmonizing content-filled variables, do not tick this box. Repeat for each measurement.

Other buttons:

Add Category: Edit the measurement values by adding a value that did not appear in the original dataset.

Comment: Keep your notes on coding decisions or other information by adding it to the comments section. This information will be stored with the variable.

Definition: Provide the theoretical definition that guides your interpretation of this measure.

Dataset: Enter in the study number (its permanent identifier, or PID), the study name and any other comments about the source of the data.
**Reset Changes**: Undoes your changes and returns the information to what was imported.

**Apply Changes**: Confirms your changes to the database. You must press this button to continue the importation process.

**Exit ‘Edit Measurement’**: Prompts the closing of the window. Confirm changes by clicking ‘Yes’.

**Help**: Click to be taken to the online Help feature.

When you have finished making your changes, click Apply Changes. Click Exit Edit Measurement. Confirm the changes you have made by clicking ‘Yes’ when prompted by the dialog box.

Next you can choose to either import the variable, skip the named variable and move on to the next or Abort all Imports. As with importing variables, this will abort the whole process including this measurement. Any measurements imported up until you click Abort will be imported into the QCS database. Confirm the importation by clicking ‘Yes, import now’.

Each target variable you import will be confirmed.

QCS confirms the total number of measurements imported.

As with the source variable importation, QCS produces a report with information on the measurements you have brought into your database. You can save this report for future consultation.
CREATE A QUICK CHARM HARMONIZATION

Each QCS project is built from a single target variable. Users can harmonize that target variable (T) to one or more source variables (S). Here we walk through a 1T to 1S variable harmonization for the concept of closer to a political party using a dichotomous ‘Yes/ No’ target variable and a 2010 British Election Study source variable.

To create a new project, click the Project button and select Create a new Project.

NAME YOUR PROJECT (PROJECT SETUP NAME REQUIRED)

Give your project a name. For better data management, we recommend you plan a project naming strategy. If you are not sure how to name your projects, we recommend a naming scheme based on the concept being harmonized, the name of the target variable study and the study (studies) name(s) of the source variable(s).

Project Summary (opt.)

Project summary are not required for your QuickCharm projects. However, you may find it useful for future reference to document your aims, strategies and concerns. Click Next when you are ready to continue.

Concept and definition (opt.)

One concept is harmonized per project. Users may add information about the harmonized concept, including definitions and references. It is not required to complete this tab before moving on, but it is good data management practice.
Click **Next** when you are ready to continue.

**HOW TO SEARCH FOR MEASUREMENTS AND SAVE THEM TO A BASKET**

After creating your project the next step is to search for the target variable (measurement) you want to work with and the source variables you want to harmonize. To add measurements to your project start a search by clicking Search → Search.

In the Search window, select Measurement to search the measurement/target variables in your database. This restricts the search only to variables that you have imported as measurements or measurements you create for your own projects.
When searching within Measurement or Variable, QCS searches the data you’ve imported from the variable name and variable label. The practice dataset uses PID (party identification) in the name of the target variable. Type pid to search your database.

Matching results will appear in the results box below. Tick the box of the target variable(s) you want to work with and click Save to Basket. After you click Save to Basket, the selected item(s) will appear in the Temp Basket.

NOTE: Change your searches from 'Measurement' to 'Variable' in drop down window. You can search for as many variables as you'd like and add them to your Temp Basket.

**HOW TO SEARCH FOR A SOURCE VARIABLE**

Select Variable to search the source variables in your database. In the window type pid to search your database. Matching results will appear in the results box below.

Tick the box of the source variable(s) you want to work with and click Save to Basket. After you click Save to Basket, the selected item(s) will appear in the Temp Basket.

Click Close when you are done.

**ASSIGN A TARGET VARIABLE NAME AND LABEL.**

A new harmonized target variable requires a unique name and label. Here we use ClserHrmd as the Target name and Closer to a party harmonized as the Target Label. NOTE: If you are harmonizing all your source variables to the same target variable name, the target name you enter here will be used for all source variables in this project.
IMPORT YOUR MEASUREMENT INTO YOUR PROJECT

Click **Import** to add your measurement. A new dialogue box with a list of **only** the measurements (target variables) that were saved to the Temp Basket will appear. Select the measurement you want from the drop down list and move it into the box. Click **Import** to finish.

BRING YOUR SOURCE VARIABLE INTO YOUR PROJECT

Click **QuickCharm** to bring up the Import Variable(s) window.
Select your variable from the drop down menu of variables in your Temp Basket. Move the variable into the box on the right-hand side. Click Import to confirm your selection.

**MAP THE VALUES**

Clicking **Import** will move you to the **Data Recoding Tab** where you will map the response options of the target variable to the source. Use the dropdown boxes to map your target variable values onto your source variable values.

When you are ready to move to the next step, first **Confirm** your mapping and then click **Next**.

When you hit **Next** you will be returned to the **Target Variable** screen. You can produce a syntax or examine your Graph or the Report.
THE REPORT AND GRAPH FEATURES

The Standard Template is the default report that comes preinstalled with the QuickCharmStats application. (To see how this template was generated see the appendix ‘The Standard Report Template’.) The Project Template assumes you have created your own template from the list of approved tags and that you want to be able to find that template quickly. You can have a different template for each project if you so choose. When you click Project Template you are able to search for the template you want to import. The next time you click Project Template it takes you to the file location of your own template. To change which template is your Project Template simply locate the correct file and open it. Project Template will always link you to the most recent template you imported.

If you would like to import a template, use Import a Template to find and import the file.

[Open] replaces the current template with the newly selected one.

[Project Template] does the same, but stores a link to the chosen Template within the project. At a later time this template will be preselected presented in the Dialog: Import a Template.

HINT: Icon #7 in the Toolbar is a short cut to the report window
[Edit] enables the user to change the report text manually.

[Print] calls the printer dialog. Using the printer dialog, you may convert the report to other formats, e.g. PDF.

[Save] calls the save dialog. Reports are HTML-Files. Exported one can be opened in Web browsers or used for presentation on a web site.

**PUBLISH CS REPORT AS HTML**

The report generated by the application is in essence a web document. As such it can be stored to the file system and integrated in a web site. Press [Save] to call the Dialog: Save, then browse the file system, select a place for the document and, if necessary change the name of the document. Press [Save] again and a document is created and stored outside the CharmStats System.

**SAVE GRAPH AS GRAPHIC FILE**

Click on the Graph window. This opens the graph view. Pressing the buttons on the left bar, different information is shown in the graph area. The one that displays the value mapping is the Target: Source button. The graphs generated by the application can be stored to the file system.
Press [Save] to call the Dialog: Save, then browse the file system, select a place for the graphic file and, if necessary change the name. Press [Save] again and a graphic file is created and stored outside the CharmStats System. Four different graphic file formats are supported: JPG (default), GIF, PNG and BMP. A picture named “mapping.png” will be shown in the report if you include the tag #MAPPING_GRAPH# in the template.

CREATING A TARGET VARIABLE AND MULTIPLE VARIABLES

It might be the case that you don’t have a target variable to import. You can create your target variable in CharmStats and it will be added to your dataset. In this exercise we will create a target variable for using in our harmonization project.

QCS allows you to layer multiple source variables onto a target variable. When you QuickChar a project the software creates the connections between the target and source variables for you. To map additional source variables you must make the connections yourself. In this section we walk you through adding subsequent variables to the same project.

EXERCISE - CREATE A TARGET VARIABLE INSIDE CHARMSTATS

In the last project we used the default coding of 1 = yes and 2 = no of the target variable. However, many researchers prefer to recode their dependent variable to start at zero instead of one. The reason for this in regression models is to have consistency when interpreting across the coefficients.

Create a new project, here we’ve given it the name ‘Closer to a party 0’. A short statement explaining this was added to the project summary. For the purposes of this exercise we will not enter anything into the Concept tab, click Next to get to the Target Variable tab.
In the last example we imported the target variable metadata into our project. This time we will create the metadata inside the project.

1) Create a Target name for your harmonized target variable. Fill in the Target Label area.
2) Indicate whether the variable is individual or aggregate level and the measurement type.
3) Create a measurement name. This will be the name stored in the database.
4) Enter in the response values, their labels. Indicate whether they are ‘missing’ values. Use Add Category to increase the number of response values, use Remove Category to delete them.
To work with a new source variable it must be in your Basket. Use the search function to find the source variables from your dataset and save it to your basket. Use the term ‘pid’ to search within Variables from the practice dataset. Select all three source variables and save to your basket. Then click Close.

You can now import the source variable metadata into your new project. On the Target Variable tab, click Import. QuickCharm the BES variable as you did in the previous project. Use the instructions above or the Tool Tip feature to help you.
When you return to the Target Variable screen, save your project.

To add a second variable, click on the Data Re-coding Step. The first tab is called D. R. Instance. The default is the name of the QuickCharm you just finished. Click Add Instance to create a new layer for variable harmonization.

Give the new instance a memorable name. I have named the practice project CLSR CAN to represent the closer to a party variable from the Canadian data. When you’re finished click Next.

The next window asks you to connect your new source variable to the overall project by importing it under its new Instance name. Click on D.R. Instance and select the new layer you’ve just created.
Use the Import button on the bottom of the screen to bring up the source variables in your Basket. From the drop down box select the Canadian variable, move it over into the box and click Import to bring it into your new CLSR CAN instance. Click Next to continue.

The next three tabs display the metadata of your source variable. Click Next three times to move through these tabs until you get to the Map Instances tab. In this window you will connect the target variable metadata to the new CLSR CAN information. The Source Instance is filled in for you. Select oi-default (same as above) from the drop down box. Click Next when finished.
Map Attribute(s) tab is next. Start by clicking Instance Pairing near the bottom of the window and select your new harmonization instance from the list.

The Source Attribute has been filled in; use the drop down box to connect it to your target variable.

Click Next to move to the last step.

The final tab is the Map Values tab, just as it was in the QuickCharm process. This tells the software which metadata to retrieve.
To bring up the new values you must select from the Instance Pairing at the bottom of the window.

Map the Canadian values. Click Confirm to connect the target and source values.

Click Next to return to the Target Variable screen.
Before adding the third variable, save your project.

To make sure you feel confident adding multiple variables, let’s add a third. This time we will add the Eurobarometer variable to our CharmStats project. Click on the Data Re-coding Step. Click Add Instance.

Give your new Instance a name. We have used CLSR EURO in the practice example. Click Next to proceed.
Connect your new source variable to the overall project by importing it under its new Instance name. Click on D.R. Instance and select the new layer you’ve just created.

Use the Import button on the bottom of the screen to bring up the source variables in your Basket. From the drop down box select the Eurobarometer variable, move it over into the box and click Import to bring it into your new CLSR EURO instance. Click Next to continue.
The following three tabs display the metadata of your source variable. Click Next three times to move through these tabs until you get to the Map Instances tab. In this window connect the target variable metadata to the new CLSR EURO information.

The Source Instance is filled in for you. Select oi-default (same as above) from the drop down box. Click Next when finished.
Map Attribute(s) tab is next. Start by clicking Instance Pairing at the bottom of the window and select your new harmonization instance from the list.

The Source Attribute has been filled in; use the drop down box to connect it to your target variable. Click Next to move to the last step.
The final tab is the Map Values tab. Bring up the new values by selecting CLSR EURO from the Instance Pairing.

Map the Eurobarometer values. Click Confirm to connect the target and source values. Click Next to return to the Target Variable screen.

Before doing anything else, save your project.
EXPORT SYNTAX

Your harmonization is done, now it is time to produce a syntax for use in your analysis. QCS automatically generates syntax in either SPSS or Stata. NOTE: Stata syntax is case sensitive. If the variable name – in this case C2004 – includes capitals, you can edit in this window to make it Stata compatible, however it will need to be done each time you generate the syntax from scratch.

Menu: Data → Export → Export Syntax

Dialog: Export Syntax comes up (Select format with [SPSS], [STATA]) → [Edit], [Print] or [Save] → [Close]

Each time you use the syntax generator CharmStats rebuilds it from scratch. To generate a syntax for your new mapping first use the dropdown box to select which syntax you want to generate. When you select the mapping CharmStats will automatically fill in the variable information for you. Note: CharmStats uses the default target name and variable label that you provide in the Target Variable tab. If you want to create new variables from each harmonization you must hand enter that information before clicking SPSS or Stata. Alternatively you can run the syntax then click Edit to make the changes. We recommend you save unique target names as a separate, external .html files.

Report feature

The QuickCharm report syntax for multiple source variables also harmonized the target variable name and label to the information provided in the Target Variable tab. Until the 1.0 version we recommend users use the Edit button on the report function to insert the syntax they prefer to the original.
Graphs for multiple source variables

QuickCharmStats automatically represents all the mappings presented in a project as an output. This allows researchers to visually inspect and confirm the mappings. It also allows researchers to identify errors in coding.

FINISH YOUR QCS PROJECTS

When a harmonization is complete you can move it from the Unfinished Projects to Finished Projects. When a project is finished it can be opened but not edited. To reopen a finished project to edit it again, see the Troubleshooting section below.

TROUBLESHOOTING

What is Troubleshooting? We define Troubleshooting as the process to repair or reset a failed workstep or process. Abnormal termination of the application for example may lead to an uneditable project.

Who can troubleshoot? Troubleshooting is reserved for users with the role of Troubleshooter. To prevent regular users from mixing up project work and inadvertent troubleshooting, users must login
into the role of Troubleshooter. The rights of a Troubleshooter are highly limited and while a Troubleshooter works with a project no other user can work with it.

**How do I troubleshoot?** To login into QCS 1.1 as the troubleshooter you must first logout as a User. The username for troubleshooting is: trouble. The password is: trouble.

**TROUBLESHOOTING PRIVILEGES (QCS 1.1)**

- Release locks on projects
- Revoke the status of ‘Finished’ on a project and return it to the Unfinished Projects folder
- Change a password

**RELEASE LOCK ON PROJECT**

Projects are locked in the database after opening. To prevent multiple people from working on the same project only one user at a time can edit them. After closing the project, the lock is removed. In case of a problem that results in your project unexpected ending, the project remains locked in the database. We will walk you through the steps that correct the erroneous lock and allow you to access it again under as a user.

To remove the lock on a project, select **Release Lock on Project** from the menu **Extra | Troubleshooting**. The ‘Release Lock’ dialog opens. Select the project to be unlocked from a combo box list. Each entry in this list names a project and the user editing it.

Press the button “Accept” to complete the process.
REVOKE ‘FINISHED’ STATUS FOR A PROJECT

When you use the command ‘Finish’ on a project it is then closed for editing. In the CharmStats Pro version, projects that are made public can be seen by all users using the database. To prevent users from accidently switching the project state between unfinished and finished revoking the finished status of a project falls under the rights of the troubleshooter.

First log out as the User and login in as the Troubleshooter To ‘unfinish’ a project and make it open for editing again, a troubleshooter first has to add the project to the basket. Using the Search function, search for the finished project and store it into the basket. Next use the command Revoke Finish from the Menu Extra | Troubleshooting. In the dialog box that opens, select the project to be listed as unfinished from a combo box list. Press Revoke Finish to complete the process.

CHANGE PASSWORD

A troubleshooter can reset a user’s password without knowledge of the old password. Selects Change Password from the menu Extra | Troubleshooting. Next, select the user whose password is to be changed and enter a new password for that user. Press “Accept” to complete the process.
DIFFERENCES BETWEEN QCS 1.0 AND QCS 1.1

Feedback sampled from CS 1.0 users and from the participants of the Fall 2014 CharmStats Workshop and progress achieved in the CharmStatsPro development resulted in a revised version 1.1 due to mid-2015. While the workflow stays the same as before, changes were made to either clarify said workflow or to support user decisions by offering more information than before.

New

Remove Variable:
- With this command unused variables are removed from the system.
- The process of removing a variable will be completed with the creation of a “removal report”, in which the process is clearly documented.
- Similar to the “project report” this document can be changed, printed or saved.

Remove Measure:
- With this command unused measures are removed from the system.
- The process of removing a measure will be completed with the creation of a “removal report”, in which the process is clearly documented.
- Similar to the “project report” this document can be changed, printed or saved.

Remove (General):
- A folder "removings" for organizing the removal reports was put alongside the folders "projects" and "templates".

Improved

Import Variable:
- Additional dialogs convey information about: Planned scope of the import process, Next variable to import, Actual import status of variable and Actual scope of import.
- Query added: Import variable (yes/no/cancel)?
- The process of importing a variable in QCS 1.1 will be completed with the creation of an “import report”, in which the process is clearly documented.
- Similar to the “project report” this document can be changed, printed or saved.

Import Measure:
- Additional dialogs convey information about: Planned scope of the import process, Next measure to import, Actual import status of measure and Actual scope of import.
- Query added: Import measure (yes/no/cancel)?
- The process of importing a measure in QCS 1.1 will be completed with the creation of an “import report”, in which the process is clearly documented.
- Similar to the “project report” this document can be changed, printed or saved.

Import (General):
- A folder „imports“ for organizing the import reports was put alongside the folders "projects" and "templates".
Search:
- The short cut Ctrl-F to go directly to the search dialog was added. It is no longer necessary to use the menu to start the search.
- A system using tooltips guides the user through the steps necessary for a search.
- The list of search results is ordered now by name and not by occurrence in the database anymore.
- Results shown from the beginning of the result list.

Open Variable Dialog:
- The list of variables is ordered now by name and not by occurrence in the database anymore.
- After selecting but before opening the variable metadata is shown.

Open Measurement Dialog:
- The list of measures is ordered now by name and not by occurrence in the database anymore.
  After selecting but before opening the measure metadata is shown.

Edit Variable Dialog:
- A warning is shown before the editor opens variables which are already in use.
- Default values are provided for variable type, sampling level and measurement type.
- “Save” button replaced by “Apply Changes” button: Original behavior was to save changes & exit the editor, now the changes are applied to the variable, but the editor is not closed.
- “Confirm” button was replaced by “Exit “Edit Variable!” button: Original behavior was to save original values & exit the editor, now the dialog is simply closed.
- Query added is: ”Apply changes (yes/no)?”.
- Close button is now disabled.

Edit Measurement Dialog:
- A warning is shown before the editor opens measures which are already in use.
- Default values are provided for sampling level, source and measurement type.
- “Save” button replaced by “Apply Changes” button: Original behavior was to save changes & exit the editor, now the changes made are applied to the measure, but the editor is not closed.
- “Confirm” button was replaced by “Exit “Edit Measure!” button: Original behavior was to save original values & exit the editor, now the dialog is simply closed.
- Query added is: “Apply changes (yes/no)?”.
- Close button is now disabled.

Project Window:
- Project list is ordered now by name and not by occurrence in the database anymore.
- Tooltip: Layout was revised for ease of use.

Basket Window:
- Object list is ordered now by name and not by occurrence in the database anymore.
- Tooltip: Layout was revised for ease of use.
Form Window:
- A system using tooltips guides the user through the steps necessary to initially harmonize through the means of the “QuickCharm” feature.
- A system using tooltips guides the user through the steps necessary for additional harmonizations.
- Variable values are now shown as code value/category label pairs at the Map Value(s) tab.
- Button “Identical Assignment” was added to the “Map Value(s)” tab. Target- and source values are mapped according to their order in the lists.
- Button “Reverse Assignment” was added to the “Map Value(s)” tab. Target- and source values are mapped contrary to their order in the lists.

Graph view:
- A toggle to switch between “Target to Source”- and “Source to Target”-orientation of the graph shown was added.

Report Window:
- Text shown from the beginning of the document.
- Logos are displayable now in three different sizes (small, medium and large).
- Up to 999 different user defined pictures are supported in report templates.

Export Syntax Dialog:
- Code shown from the beginning of the syntax.

General:
- A splash screen is now displayed when the application starts.
- Waiting cursor indicates necessary waiting periods.
- Dialogs are now centered to the application frame, not to the monitor any more.
- Standardization of terms was exercised.
- Labels have been changed to self-explanatory, unambiguous terms.

Removed

Import Variable:
- “DDI 3.1” was removed from the list of supported data formats. A more substantial DDI support will be made available again after the release of CharmStatsPro.

Import Measure:
- “DDI 3.1” was removed from the list of supported data formats. A more substantial DDI support will be made available again after the release of CharmStatsPro.

Form Window:
- “Meso” was removed from the list of supported sampling levels on the “Target Variable” tab, as it is considered to be only a special case of “Aggregate / Macrodata”.

General

Further improvements to overall application stability and other minor adjustments have been made.
This Quick Start guide assumes you have already done the background research, documentation gathering and data preparation necessary to get the most out of CharmStats (See Section X: Get ready: collect your documentation, create a plan).

**QUICK START DATA IMPORTATION: IMPORT VARIABLES FROM AN SPSS DATASET**

Data → Import variable  
Select variable source input → .sav (location on desktop)  
File name → Open (.sav file)  
From list, select variable(s) for import → Import  
Edit variable → Can add 'Missing' to variables. (Tick Missing box to indicate non-valid responses)  
→ Edit metadata (optional)  
→ Save

**CREATE A QUICKCHARM PROJECT, SEARCH FOR AND IMPORT VARIABLES, CREATE SYNTAX**

New project  
Project → Create New Project → Name project → Next  
Concept tab (optional) - name concept → Next  
Literature tab (optional) – name sources → Next

**SEARCH FOR AND SAVE MEASUREMENTS AND VARIABLES INTO YOUR BASKET**

Search → Search  
Select → (Drop Down Box options: Measurement, Project, Variable)  
→ Text box: Type in letter, word portion or word  
Search → Save results to basket → Close

**CREATE A NEW QUICKCHARM**

Target variable tab  
Target name → name target variable →
Target label → enter Target label (normally the question wording) →
Data type (optional) → assign level → Measurement type (optional) assign type →
**Import** button → **Import** measurement
User should visually check the coding → ‘QuickCharm’ button → **Import** variable
Map values → (User should visually check the coding) Confirm → **Next**
Syntax window opens.
Select format (SPSS, Stata, SAS, MPlus) → Edit, Print or Save

**EXPORT SYNTAX FROM AN EXISTING PROJECT**

Project → Select project → Open project
Data → Export Syntax
Select format (SPSS, Stata, SAS, MPlus) → Edit, Print or Save
APPENDIX B: QUICK CHARMSTATS MENU STRUCTURE

- **File**
  - Exit

- **User**
  - Login
  - Logoff
  - Change Password

- **Data**
  - Import
    - Import Variable
    - Import Measurement
  - Edit
    - Edit Variable
    - Edit Measurement
  - Export
    - Export Variable
    - Export Syntax
  - Remove
    - Remove Variable
    - Remove Measurement

- **Project**
  - Create new Project
  - Open Project
  - Close
  - Save
  - Finish *(visible only with open project)*
  - Remove *(visible only with open project)*

- **Basket**
  - Open My Basket
  - Close My Basket
  - Save My Basket
  - Empty My Basket
  - Empty Temp Basket

- **Search**
  - Search…

- **Extra**
  - Settings
    - Font size
      - Increase Font size
      - Decrease Font size
    - Language
      - English
      - German
  - Help
    - Help
    - About QuickCharmStats

**User trouble**
(Troubleshooter) has access to special commands:

- **Extra**
  - Troubleshooting
    - Release Lock on Project
    - Revoke “Finish”
    - Change Password
APPENDIX C: FAST ACCESS TO MENU THROUGH SHORT CUTS:

[Alt] + f  Menu File
[Alt] + u  Menu User
[CTRL + l]  Login
[Alt] + d  Menu Data
[Alt] + p  Menu Project
[CTRL + n]  Create new Project
[CTRL + o]  Open Project
[CTRL + w]  Close Project
[CTRL + s]  Save
[Alt] + b  Menu Basket
[Alt] + s  Menu Search
[CTRL + f]  Search…
[Alt] + x  Menu Extra
[CTRL + NumPad+]  Increase Font size
[CTRL + NumPad-]  Decrease Font size
[Alt] + h  Menu Help
[CTRL + F1]  Help
APPENDIX D: TOOLTIP WORKFLOW

SEARCH

Search dialog
#01: Select a Type of Search object
#02 Search term
#03 Scope of Search (opt.)
#04 Start Search
#05 Select Result
#06: Save Search results(s) to Basket
#07 Close

QUICKCHARM

Target Variable Tab | Target Variable Tab
#01: Enter Target Name
#02 Target Label
#03: Import Measurement
#04: QuickCharm Measurement w/ Variable

Data Re-coding Step Tab | Map Value(s) Tab
#01: Choose Instance Pairing
#02 Attribute Pairing
#03 Value(s)
#04 Confirm
#05 Next

ADDITIONAL HARMONIZATIONS

Data Re-coding Step Tab | D.R. Instance Tab
#01: Add Instance
#02: Enter Instance
#03 Next

Data Re-coding Step Tab | Variable(s) Tab
#01: Choose Instance
#02 Import
#03: Next Step

Data Re-coding Step Tab | Map Instance(s) Tab
#01: Choose Target Instance
#02 Next
Data Re-coding Step Tab | Map Attribute(s) Tab
#01: Choose Instance Pairing
#02: Choose Target Attribute
#03 Next

Data Re-coding Step Tab | Map Value(s) Tab
#01: Choose Instance Pairing
#02: Choose Attribute Pairing
#03: Map Value(s)
#04: Confirm mapping
#05 Next
APPENDIX E: LIST OF TAGS SUPPORTED BY THE REPORT GENERATOR:

(Tags followed by * are only needed for problem solving.)

#USER#  #AUTHORS#  #NICE_LIST_OF_AUTHORS#
#TARGET_NAME#  #TARGET_LABEL#
#SYNTAX_SPSS#  #SYNTAX_SPSS_NUMBERED_LIST#
#CROSS_TAB_SPSS#  
#SYNTAX_STATA#  #SYNTAX_STATA_NUMBERED_LIST#
#CROSS_TAB_STATA#
#PROJECT_NAME#  #PROJECT_SUMMARY#
#CONCEPT_NAME#  #CONCEPT_DEFINITION#
#ALL_INSTANCES#*  #CS_INSTANCES#*  #OS_INSTANCES#*  #DC_INSTANCES#*
#MEASUREMENT#  #MEASUREMENT_NAME#  #MEASUREMENT_SAMPLING_LEVEL#  #MEASUREMENT_LEVEL#  
#MEASUREMENT_RESPONSE_OPTION#  #MEASUREMENT_DEFINITION#
#TARGET_DATASET#  #TARGET_PID#
#DIMENSIONS#  #BLUEPRINTS#  #VARIABLES#  #VARIABLE_NUMBERED_LIST#  
#SOURCE_VARIABLES_DATASET_DESCRIPTION#  #INST_MAPPINGS_REK#*  
#INST_MAPPINGS#*  #ATTR_MAPPINGS#*  #CHAR_MAPPINGS#*
#SMALL_LOGO#  #MEDIUM_LOGO#  #LARGE_LOGO#  #MAPPING_GRAPH#  
#USER_PICTURE_001#  ...
#USER_PICTURE_999#  #ALL_COMMENTS#  #PROJECT_COMMENT#  
#PROJECT_COMMENT_WITHOUT_SUBJECT#  #CONCEPT_COMMENT#  
#CONCEPT_COMMENT_WITHOUT_SUBJECT#  #TARGET_COMMENT#  
#TARGET_COMMENT_WITHOUT_SUBJECT#  #DC_INST_COMMENT#  
#DC_VAR_COMMENT#  #DC_VAL_COMMENT#  #DC_INST_MAP_COMMENT#  
#DC_ATTR_MAP_COMMENT#  #DC_CHAR_MAP_COMMENT#
APPENDIX F: THE STANDARD REPORT TEMPLATE

QuickCharmStats: Lite Version of CharmStats - Coding and Harmonization of Statistics

Powered by GESIS

Project: #PROJECTNAME#

Project note: #PROJECTNOTE#

SPSS syntax: #SYNTAX_SPSS#

Stata syntax: #SYNTAX_STA#

Project Setup Tab

Project name: #PROJECTNAME#

Note: #PROJECTNOTE#

Comments: #PROJECT_COMMENT#

Concept: #CONCEPTNAME#

Definition: #CONCEPTDEF#

Concept comments: #CONCEPT_COMMENT#

Target Variable Tab

Measurement name: #MEASUREMENT#

Target name: #TARGET_NAME#

Target label: #TARGET_LABEL#

Target comments: #TARGET_COMMENT#

Source variable: #VARIABLES#